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Quartus Il Web Edition
Release date: June, 2013 (—‘
Latest Release: v18.1 aua"tus'

T ; Design Software
Select release:|13.0sp1 v |

Operating System ""m.’ Windows © ;3 Linux
Select the operating system on which you will rum the Quartus || software.

Download Method ® Akamai DLM3 Download Manager ' Direct Download

Select whether you will use the downtoad manager {Windows only) or directly download the files.
The download manager allows you to pause the download and can help you recover from interrupted downiloads.

You may be exposed to a vulnerability issue if you have Installed or plan to install Quartus Prime/Quartus || software from

v11.0 to v18.0 to a location with space(s) in the path. See this KDB solution for more details.

& The Quartus || software version 13.0sp supports the following device families: Arria I, Cyclone II, Cyclone lIf, Cyclone
IV (includes all variations), Cyclone V {includes all variations), and MAX [I, MAX V, MAX 3000, MAX 7000. . More

Combined Files | Individual Files | DVD Files

Download and install instructions: - More
Read Intel FPGA Software v13.0 Installation FAQ
Quick Start Guide

[E Select All

[¥]Quartus 1l Web Edition (Free)

[“IQuartus Il Software {includes Nios Il EDS)
Size: 1.5 GB MD5: 70D2991B55E70EEFBBA30DB328A40BFO1

[“IModelSim-Altera Edition (includes Starter Edition)
Size: 779.3 MB MD5: 97D829F95E3BDFAZAD15891F00936D10
[ Devices
You must install device support for at least one device family to use the Quartus |l software,
[“|Arria Il device support
Size: 457.2 MB MD5: 18262271D276A9966F42938E1E601 AEE
[“ICyclone II, Cyclone [ll, Cyclone IV device support (includes all variations)
Size: 568.9 MB MD5: CDAC3B23F0DF21D7371E439503100089
[[ICyclone V device support (includes all variations)
Size: 747.9 MB MD5: 4664B9BDD482C004C3C8D64FEFC124AB
[CIMAX 11, MAX V, MAX 3000, MAX 7000 device support
Size: 6.7 MB MD5: 64AACABCAF6CD545D449BE3FFDECBASO
H Additional Software
[lQuartus Il Programmer and SignalTap Il
Size: 136.6 MB MD5: F2F4B22D642DF1CB38AC6360474C70CC
[“IQuartus 1l Help
Size: 355.8 MB MD5: COFB2D2D2E

D936CE18F00B0BT7985AB6
["]SoC Embedded Design Suite (EDS)
Size: 1.2 GB MD5: 55B7C AC4DT765AT72843D407121A25

[[] Linux Support Package Binary File
Size: 387.0 MB MD5: CC7736BE6SB51C318CEBC51A4Ba5538

[l Linux Support Package Source File
Size; 818.3 MB MD5: 587688F0DA87F549333E9432BE8268103

Download Selected Files Troubleshoot downioad problems
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Setup - Quartus || Web Edition [Free) 13.0.1.232

“wielcome to the Quartus || web Edition [Free) 13.0.1.232 Setup Wizard.

Far more infarmation about Altera software, go to httpcd fuvy. altera,com.

< Back Newt s I Cancel

Installing Quartus.

Select Components M-;m
®

Select the components you want tinstall

= V] Quartus Il Wb Edition [Free] Select a companent bor mare intarmation
[@] Duartus || Sottwars fincludes Nis || EDG] (444008
1 Quartus | Softeare BA-bit sunoort (3528B)
= [7] Devices
[Z] Cyclone L2114V [E15.2MB)
[¥] Mas11AY, M 3000/7000 [3.1MB)

BitFiack [nstaller

< Back || Next > || Cancel
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€; Installing Quartus T Web Edition

“whait while Setup installs Quartus || Web Edition (Free] 13.0.1.232

Installing

Preparing to Instal

BitFlack [nstaller

< Back fest »

&4 Quartus T 64-Bit 13.0 Web Edition .

Thank you for installing the Quartus II Web Edition software - the #1in
performance and productivity, To upgrade to the full featured Subscription Edition,
please visit www.altera.com..

Select one of the following licensing options to continue:

Select one of the following options

(") Buy the Quartus IT Subscription Edition software

'@ Run the Quartus II software

(1 Add an IP license file {for users who have purchased IF)
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@ Generic USB Hub
..... § Generic USB Hub

a Microsoft Mouse and Keyboard Detection Driver (USB)
..... § USB Composite Device
§ USB Root Hub
§ USE Root Hub
USB Serial Converter
PIER) USE 3.0 RE 5|2
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& Open... chrl+0
Close Cti+Fq

New Froject Wizard. ..
Open Project. .. Crl+
Save Project

W[e

Cinse Project

b Save cri+s
Save As..

@ Sevedl Crrl4shift4s

Fiz Propertiss,,

Create / Update »
Export

n . ]
e B
w Buy Software
Convert Programming Fies. ..

) View Quartus Il
Page Setup... Information

Print Preview @ Documentation

Print., cul+® @ Notification Center

DEE

Recent Files ¥

Recent Frojects »

Exit Alt+F4

\=\_system /\ Process
Starts the New Project Wizard 0% 00:00:00

&

‘Quartus [1'9] —2 3L project @2 AlSL]7] w20 WA ATSt projectE s
o] zojof 3t} ‘File -> New Project Wizard...'& X Ei5}o] A|2-& projectES THEC}

- ‘New Project Wizard'E AlSi5tH WA 'Introduction’ #o] UehACt 'Introduction’ A¢
2 s gojE & d@r|d =, o]F SEAo] ZA projectE sttt

- Directory= project’} §t5ojX|= AtA 2 U5}
20|08 top-level entity= T =& 0|9} =25}A
shojof gt

X2 XA st Name project?] o]
AR AIZITEH &, FEAIY RAHS AMS

Directory, Name, Top-Level Entity [page 1 of 5]

\What is the working directory for this project?

E:/Lecture/UnderGraduate/Digital Circuits and Microcomputer System Lab I/2018-1/Lab Manual/Figs/Test E] I
Vihat is the name of this project?
=] ]

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match the entity name
in the design file.

Test =5
[Use Existing Froject Settings...

[ <gack | [ next> ][ rFmisn | cancel |[ help |




- Ohg2 ‘Add Files'olt}. 2 AEoA& LA o2 51t9] projecto] shto] design file&

AFE-SHAR|GE, ARI2 she] project= TF49] design fileZ 7HE £ Q. 1 & 7]E&0

ot5o] & design fileS Ar2sH= QU librariess Ar2sH= 749 'Add Files'S 53
T

Add Files [page 2 of 5]
Select the design files you want to include in the project. Click Add Al to add all design files in the project directory to the project.
Note: you can always 30d design files to the project later.
Fie name: (i) Add
FileMame Type Lbrary Design Entry/Synthesis Tool HOL Version @
 Remove
Up
Down
Prapertizs
Spedfy the path names of any non-default lbraries, |Uses Libraries...
(b |[ Mest> J[ posh [ concd |[ oo |

S ‘Family & Device Settings'o|t}t. AF2S AXpo] @t program £3Fo|u; AFR7}
A

o
=]
S

I gate, macrocell®] £7} Th20, pin®| & R HX|7} D2} o]F A5 Fofof gt

hi

manualo] A= ‘Cyclone IV E’ Family?] ‘EPACE6E22C8' AA}S MEsto] RIsRstc},

e of L

Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu,

Show in "Available devices' list

Davice family
| Famiy: [cyclone v £ o] || rackage:  [mam -
Devices; ‘:A-“ “! Pin count: lA.ny -'~]
Target device Speed grade: IAny -]
) Auto device selected by the Fitter Name filter:
1@ Specific device selected in 'Available devices' list [¥] Show advanced devices HardCopy compatible anly =]
other: nfa
Available devices:
Name Core Voltage LEs User I/ 0s Memory Bits Embedded multiplier 9-bit elements Iil

6272 92 276480 30

ol [oem |

EPTL(’FEF 2 1.0V 6272 92
4 il

276480 30

Companion device =

HardCopy:

Limit DSP & RAM to HardCopy device resources

< Back ][ Mext > ][ Finish ]I Cancel H Help.
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EDA Tool Settings [page 4 of 5]

Spedfy the other EDA tools used with the Quartus II software to develop your project.

EDA tals:
Tool Type ool Name Farmat(s) Run Tool Automatically
Design Entry/Synthesis | <Nene> ] <tione> + [ Run this tool automatically to synthe
Simuation <hone> x| <tores> -
Formal Verfication | <liane =
Board-Level Timing <Nane> R
Symbal | chone> -
Signal Integrity [Mone> =]

i

<pack | [Chet> ] [ Fosn | [ cance ] [ hew

- OFX]9}2 'Summary'o]t}. projects A/dst7] A AHE A3
M=ZF projects AB/dstct gt o] TAofA AR A5 of

N
2 37 A¥E wer Yok

A% 5 Finish'S 5}o]
& UEo] 20| Thssto

Summary [page 5 of 5]

When you click Finish, the project will be created with the following settings:

| Project directory: E:/Lecture/UnderGraduate/Bigital Circuits and Microcomputer System Lab 1/2018-1/Lab Manual/Figs/Test
| Project name: Test

Top-level design entity: Test

Number of files added: 0

Number of user libraries added: 0

Device assignments:

Family name: Cyclone IV E
Device: EP4CEGE22CH

EDA tools:
Design entry/synthesis: <None> (<Mone>)
Simulation: <None> (<Mone=)
Timing analysis: 0

Operating conditions:
VCCINT voltage: 1.2v

Junction temperature range: 0-85 °C

<sgack || Hest > | Finish H Cancal H Help
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[ OpenProject... Cul#l
‘Save Project
Close Project
e save Ctri4s
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Fil= Froperiiss, . -
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Export.
Convert Programming Fies... Version 13.0
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Mew Quartus IT Project -
Diesign Files K
AHDL File

1Y

Block Diagram,Schematic File

EDIF File

Qsys System File

State Machine File

System\Verilog HDL File

Td Seript File

| YarlagHBLF)

|VHDL File |

[T —

4 M
' Hexadecimal (Intel-Format) File
Memory Initizlization File
. 4 Verification/Debugging Files
In-System Sources and Probes File
Logic Analyzer Interface File
SignalTap II Logic Analyzer File
University Program YWF
Other Files
AHDL Include File
| Block Symbal File
Chain Description File L
Synopsys Design Constraints File
TextFile L
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Search altera.com
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|Project vavigator  BEx| @ Vhel1.vhd
Entiy FaNT

ol Mﬁ HEw | 2OE

Ay Cyclone IV E: EP4CEGE22C8 1
# Testém

< | m, ] ¥
& tiraichy For

I
[Tasks REx

P fcusomi. |

Task

4 b compile Design
B Analysis & Synthesis
» b Fitter (Flace & Route)
B Assembler (Generate pi
» B TimeQuest Timing Anal
B EDA Netlist Writer
4 Program Device (Open Prog

[— — Ve

(D @] &) @) le] 7 -

<Search>> v

Type ID

Message

ssages = O K\

e

System /\_Processin

ln1

Col 1

'VHDL File 0%

00:00:00

o
.

- otz T2 ‘Half Adder’@] ofA]o]ct.
2 gof glom,

=)
?‘T\_}\H

0]2 ‘entity name’o]2} 3tc}.

‘New Project Wizard o] A& 3t T 'top-level entity'?t @& o] 9100, projectd]

3=l design file & U= HEEA]

_Cl

Aprsioz

'top-level entity'@?} =3t ‘entity name’o]o]of

Ol15tH ‘Test’

J

ol K

File Edit View Project Assignments Processing Tools Window Help 5/

Search altera.com )
DEEd & 2l 9o (e @Y - $¥9 0PV OO ERO B & 8/
Project Navigator 78 x| @ vhdi1.vhd* 3 |
Entity B AT nEranm 0 8 2 E
¥ Cyclone IV E: EP4CE6E22C8 1 -- import std_logic from the IEEE library ‘
2 library TEEE;
3 use TEEE.std logic 1164.all;
a
5 -- this is the entity
6 Hentity| T is
7 Hport ( A: in std_logic;
< | [ 8 B: in std logic;
4 ierarchy | ) Piles | B | 9 SUM: out std_logic;
10 COUT: out std_logic);
| Tasks sEx|| g end entity
Flow: [Cnmpi[abun ‘] [Cu_stom;za...] 12
13 -- this is the architecture
Task  “l| 14 Harchitecture MY_HALF_ADDER of| Test]is
4 Compile Design 15 H begin
- b Analysis & Synthesis|= 16 SUM <= A xor B;j
& Fitter (Place & Route 17 COUT <= A znd B;
# Assembler (Generate || 18 end architecture MY_HALF_ADDER;
B TimeQuast Timing Al 19 -- end of file
e ENA Maict Wrikar
‘ 4] I 1 [t r
;- All @ @ T <<Search>> A
RilType ID Message
g
g
gl
| 2/\_system /\_Processing /
Ln 16 Col 22 WHDL File 0% 00:00:00
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iVHDL Fileg {=vhd = vhdl}
v Addfile to curent project

M

Compile 3}7] Y3l ‘Processing -> Start Compilation'2 AIS§A]7| A+, ©& tool bar?]
‘Start Compilation‘ofo] 22 ApLstc},

Quartus I 54-81 - . . :
File Edit WView Project Assignments P Tools  Window Help - %?&Eitera.tom @
DEEHS 4 2B 9~ E . Stop Processing Ciri+Shift+C . @ e & "1& ,ﬁ b % Ale 3
[project Navigater 2@ x | [ # start Compilation Ctri+L |
Entity %4 Analyze Current File A & | 2EE
/% Cyclone IV E: EP4CEGE22C8 [ Start * BEEE library %
> Test 4 Update Memory Initialization File

\9 Compilation Report Ctri+R
P! P

; }Yﬂﬁ nic Synthesis Report

'y pr

{

~  PowerPlay Power Analyzer Tool

Y 5SN Analyzer Tool
] I | * g BT 1IN SLu_JOBIC;
.&Hierarchy | E]thes | e D:dl}l ) SUM: out std_logic;
1@ [ COUT: out std_legic);
l;lﬁlx‘ 11 end entity Test;
| L
Flow: Iﬂ pilation '] |Custnmlze_...l 12
13 -- this is the architecture
Task “/| 14 Harchitecture MY_HALF_ADDER of Test is
a4 @ Compile Design 15 H begin
I+ Analysis & Synthesis| = 16 SUM <= A xor B;
» B Fitter (Place & Route 17 COUT <= A and B;
I B Assembler (Generate 18 “end architecture MY_HALF_ADDER;
# TimeQuest Timing Al 13 -- end of file
L B CNA MeHick \Wribar " M1
4 1 | 3 4 I | »
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File Edit View Project Assignments Processing Teals Window Help 57 Search altera.com @
DEHS %@ 9 o - D g OO0 S A e
|Praject avigator Rax| [ @ Testvhd “  Compilation Report-Test [
Entity of Contents & How Summary
/% Cyclone IV E: EP4CE6E22C8 2 Flow Summary Flow Status Successful - Thu Mar 29 19:02:11 2018
B8 Test ) == Flow Settings Quartus II 64-Bit Version 13.0.1 Build 232 06/12/2013 SP 1 5] Web Edition
=2 Flow Non-Default Global Settings || Revision Name Test
=4 Flow Elapsed Time Top-level Entity Name Test
) ) =9 Flow 05 Summary _Family Cyclone IV E
< [mmad 'l & Fowlog Device EP4CESE22C8 |
(i Hierarchy ‘ =] Files | o pesign L 4| || v [ Analysis & Synthesis Timing Models Final
b <
Siaie e | b _-_| Eitter Total logic e!en_'len?s ) 2/6272(<1%)
= -IJ Flow Messages Total <
Module %  Progress | = r
Bl bt i .1) Flow Suppressed Messages Dedicated logic registers 0/6,272(0% )
Full Compilation [ 100% | © ] Assernbler Total registers o
Analysis & Synthesis e & L TimeQuest Timing Analyzer Total pins 4/92{4%)
Fitter 100% Total virtual pins 0
Assembler 100% Total memory bits 0/276,480 (0 % )
TimeQuest Timing Analyzer | 100% Embedded Multiplier 9-bit elements  0/30(0% )
Total PLLS 0/2(0%)
Pl i ] kR 1 | »
= =
&
Bl type ID Message -
\i‘) 332140 No Hold pa £g report
[} {0 Recovery pathsa to report
Removal paths to report
No Minimum Pulse Width paths to report
Design i= not £ ¥ constrained for setup requirements
Design is not 1y constrained for hold reguirements
Quartus II 64-Bit TimeQuest Timing Analyzeér was succesaful. 0 errors, 5 warnings ‘_|
@ 4) 283000 Quartus II ompilation was successi 0 errors, 12 warn =]
_EI\ System /\, Processing (113) /




@® Pin Planer & Programmer

- 'CPLD’, 'FPGA' £AH= '1/0 PORT & o7 AL&LA] ARGAP} X7 sho]of

2

=5

- ‘Assignments -> Pin Planner'2 AME5tA1} @& tool bar?] 'Pin Planner'E ARg-str},

File Edit View Project I Assignments | Processing Tools Window Help 5 Search altera.com @
D W@ b G2 Dovie. FS9 0 r@ B0 ER QB A 03
atar | St & Compilation Report - Test [
Er TimaQuest Timing Analyzer Wizard...
/B Cyclone IV E: EP4CEGE22: & | Ashgnment Editor R Flow Status Successful - Thu Mar 29 19:02:11 2018
?S;‘ Test & — = uartus II 64-Bit Version 13.0.1 Build 232 06/12/2013 SP 1 51 Web Edition
4# Pin Planner Ctrl+Shift+N I.Ievision e Test
Remave Assignments... Top-level Entity Name Test
1'% Back-Annatate Assignments... Family Cyclone IV E
[ Import Assignments... Device EP4CE6E22C8
% Hierarchy | Files | Export Assignments... Timing Models Final
‘ Assignment Groups... Total logic elements 2/{6272({<1% )
Status A i ) Total combinational functions 2/6272{<1%)
Module 2 Logiclock Regions Window Al Dedicated logic registers 0/6272(0%)
Full Compilation 5 Design Partitions Windaw Alt+D Total registers 0
Anzlysis & Synthesis |__100% A TimeQuest Timing Analyzer Total pins 4/92(4%)
Fitter Total virtual pins a
Assembler Total memory bits 0/276480 (0% )
TimeQuest Timing Analyzer 100% Embedded Multiplier 9-bit elements  0/30( 0% )
Total PLLs 0/2(0%)
! i | Fl el [ IR [ ] ¥

Edit View Processing Tools Wi Search altera.com @
= [Report 0 Bank Usage #o x|
Report not avallable 1O bank Assignabl Used pins Available
= s v s S0 s v v e e e 0 e e T i 1 e £ T - =
o * QOOOVACOAOAGBVACOROOOVADCAVANOOOBBON o s 0 s
1y
) 2Ol 3 1 0 1
) e 4 14 0 14
i + X 5 13 0 13
= g 6 10 0 10
“ : 2 ) 7 13 0 13
o~ +® TOp View 8 12 0 12
Grotps | Report | &
Tasks 2ex s g Wire Bond, with Exposed Pad
¥ Run Analysis and Elaboration |
4 | Early Pin Planning o)
] Early Pin Planning... w
# Run YO Assignment Analysis =y
1 Export Pin Assignments... o
’3‘3 I {1 Change View :;/6\
5 T Pin Finder... N
o) (1 Highlight Pins i
o x 9
= =0
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-
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5@
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® (0]
ARDAVOOOAAATOE (oy\elololererale]
TREm A GG LG ES RS @momennR
%] Nomed: = ~ o] it ¢ [ | Fiter:[Pins: all -
s Node Name Diraction Location 70 Bank VREF Group  Fitter Location /0 Standard Reserved  CurrentStrength  Slew Rate  Differential Pair
A Tnput PIN_10 2.5V (default) 8mA (default)
1 Input PIN_11 2.5 V (default) 8mA (default)
4 cout Qutput PIN_144 2.5V (default) 8mA (default) 2 (default)
2|24 sum Output PIN3 2.5V (defautt) 8mA (default) 2 (default)
o <<new node>>
=
0% 00:00:00




2 ool £ o] 42 A% Ao B U £ o] 53 Als SUMI}F COUTO sidste
Ping 23l Zolof sich

- 2 oJHolq AtRste AR FPGA MEol: el Alsg i 2Ist] st 10749 2
elol= 29jx7} nfdiElo} Qlon], mek &2 Also] HEIS uUehys] 9] 107]e] LED7
ofaislo] 9ok oS AE AR|o] TP W offet ot

BANK 1/0 s BANK 1/0 Is
B7 I/0 126 SW 0 B6 /O 100 | LED O
B7 /0 127 SW 1 B6 IO 101 | LED 1
B8 I/0 128 SW 2 B6 I/O0 103 | LED 2
B8 I/0 129 SW 3 B6 I/O 104 | LED 3
B8 I/0 132 SW 4 B6 I/O 105 | LED 4
B8 I/0 133 SW 5 B6 I/O 106 | LED 5
B8 I/0 135 SW 6 B7 /O 110 | LED 6
B8 I/0 136 SW 7 B7 I/0 111 LED 7
B8 I/0 137 SW 8 B7 I/0 112 LED 8
B8 I/0 138 SW 9 B7 I/0 113 | LED 9

- 2 A= SW_0(I/0 12602 A =, SW_1(1/0 127)& B 2!, LED_0(I/0O 100)&
SUM &2, LED_1(I/O 101)& COUT &0 tstct.

.

%] Named: ~ [ edin: 50 ]
g‘ Node Name Direction Location /O Bank VREF Group Fitter Location /O Standard Reserved Current Strength Slew Rate Differential Pair
oA Tnput PIN_126 7 B7_ND PIN_10 2.5 V {default) 8mA (default)
5B Input PIN_127 7 B7_ND PIN_11 2.5 V (default) 8mA (default)
24 CouT Output PIN_100 6 86_NO PIN_144 2.5 V (default) 8mA (default) 2 (default)
| o4 SUM Output g 8mA (default) 2 (default)
& | <<new node>> PIN_101 T0BANK_6 Row /0 DIFFIO_R3n, nCEQ | =
= PIN_103 T0BANK 6 Row /0 DIFFIO_R3p, CLKUSR
IOBANK 6 Row /O DQSOR/CQIR,DPCLKS

I0BANK_6 Row /O VREFBSNO

T0BANK_6 Row /0 DIFFIO_R1n, DQS2R/CQIR

T0BANK_7 Column /O DIFFIO_T20p, DQSOT/CQ1T,DPCLKE
TOBANK_7 Column /O DIFFIO_T19p E
T0BANK_7 Column /O PLL2_CLKOUTn

T0BANK_7 Column /O PLL2_ CLKOUTp

T0BANK_7 Column /O RUP4

- ‘Node Name'& entityo]]A] A<9lst PORTZ 9juojstt}t. ‘Location’2 Z25te] PIN'S X]
gol & 4 on, x7go] © PIN' T_’\Hoﬂl\i Moz Aol wpHym, AR PIN'9]
XA o] Y™ ‘Pin Planner #AF2 wirt}
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[A32 FPGA WEo] AAo w2 %7} Ax}t

'Device' Aol A 'Device and Pin Option...'&

1. ‘Assignment’

Pin Option A4 ]

ull
G

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

Other: nfa

Device family Show in 'Available devices' list
Family: Icyclone NME x. Package: [Any 'J
Devices: [all <] Pincount:  [any B
Target device Spedt ofpds; [Any 'J
Name filter:

Auto device selected by the Fitter

'@ Specific device selected in 'Available devices' list

Available devices:

[¥] Show advanced devices |

Device and Pin Option:

HardCopy compatible only &

Hame Core Voltage LEs User 1/0s Memory Bits Embedded multiplier 9-bit ( *
EP4CEGE22A7 1.2v 6272 92 276480 30 ‘*‘
EP4CE6E22C6 1.2v 6272 92 276480 30

EP4CEGE22C7 1.2v 6272 92 276480
_—
EP4CEGE22C8L 1.0v 6272 92 276480

EP4CEGE22COL 1.0v 6272 92 276480 30

EP4CEGE22I7 1.2v 6272 92 276480 30 -
a] it I »

Migration compatibility

Migration Devices...

0 migration devices selected

Companion device &

HardCopy:

Limit DSP & RAM to HardCopy device resources

[z Buy Software] [ ok

| [ concel |[ Help

'Category' &0 A 'Unused Pins' &3 A€

'Reserve all unused pins'ol A 'As input tri—stated'%— A=

@EE and Fin Options - Tt S-SR S — ——— ——

=.

Category:

General
Configuration

Programming Files
Dual-Purpose Pins
Capacitive Loading
Board Trace Model
/0 Timing

Voltage

Pin Placement

Error Detection CRC
CvP Settings

Partial Reconfiguration

3. 'Category’

gF&o] A 'Dual—Purpose Pins' &%
'"mCEQ'e| A 'Use as regular I/0' 3&-&

Specify device-wide options for reserving all unused pins on the device, To reserve individual dual-
purpase configuration pins, go to the Dual-Purpose Pins tab. To reserve other pins individually, use
the Assignment Editor.

Reserve all unused pmsl |As input tri-stated T ‘I

S A Ed

= T .

A

e 3l PIN Options - Tect " S s i . S f——— - —

Category:

General
Configuration
Programming Files

g
Board Trace Modal
/O Timing
Voltage
Pin Placement
Error Detection CRC
VP Settings
Partial Reconfiguration

.'OK'E =9 98,

Dual-Purpose Pins

Specify how dual-purpose pins should be used after device configuration is complete. The default
settings for each pin depend on the current configuration scheme selected in the Configuration
tab, which is: Active Serial

Nota: Far HardCopy, these settings apply to the FPGA prototype device.

Dual-purpose pins:

Name Value
DCLK Use as programming pin
Data[0] As input tri-stated
Data[1]/ASDO As input tri-stated
Data[7..2] Use as regular [/O

FLASH_nCE/nCS0O As input tri-stated
Other Active Parallel pins_Use as regu\ar /0

nCEQ Use as reqular 'O i
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i5 11 |

File Edit View Project Assignments [Processing | Tools Window Help
NEE@ 6 a@d 9 & E &) Stop Processing Ctri+Shift+C o
iggojg_cﬂdgnggtor B&| b Start Compilation Ctrl+L | con
Entity %4 Analyze Current File mar]

I iy Cyclone IV E: EP4CEGE22C8 Start ros

58 Test 4 Update Memary Initislization File 64t
4g¢  Compilation Report Ctri+R e
<[] & Dynamic Synthesis Report e

%I—& HRerarchy Sl Fies | & Design !ﬂ -j}’ PowerPlay Power Analyzer Tool
!Status A& | SSN Analyzer Tool idels
I vanaE & saEees b g~ e TTTatal Tamir alar

- Compileo] &8E®H ‘Tool -> Programmer & AMEi5IA1} @& tool bar9]

‘Programmer’S AlS§A|7IT}H.

File Edit WView Project Assignments Processing Tooi.-‘: Window  Help
DEHda # 2@ 9 > ._ Test Run Simulation Tool b

= %n  Launch Simulation Library Compiler
Project Navigator 1aod [l . it
- T 'S, Launch Design Space Explorer
Entity (Table of |
/% Cyclone IV E: EP4CERE22C8 B3 A & TimeQuest Timing Analyzer
&b
e Test el Advisors L4
=== Rl
« [T R =8 Fll & Chip Planner
| i Hierarchy | E| Files | 4+ Design | 1| }l ? FI 4 Design Partition Planner
- S Netlist Viewers ;
'Status 18x] > ma
Module % Progre: || b 3 Fi 1 SignalTap II Logic Analyzer
Full Compilation |J (i fI| = In-System Memory Content Editor
o R I . > Li2 Al =] Logic Analyzer Interface Editor
» [ A¢ ] In-System Sources and Probes Editor
Tasks rax]|, @m SignalProbe Pins...
Flow: Ic_qmpftatign v] Igustqmize...] Programmer |

sle

Tagk | JTAG Chain Debugger



- ofgfo] Te AlsiEl ‘Programmer’ @] StHO 2 AR AX}9] o]2ut ME Jh=sh SM0]
A FerA FEIR E]of T}

- gt ozl ™o EA|E HieF Z4o] ‘No Hardware' AMEj2 HA]E|H USB-Blastertt
FPGA Board’} |ZAEA] ¢4 Zlojoz

2) FPGA Boardof] le AY A9R|E ON A7l 2,
3) ‘Hardware Setup’ &2 Z2l5to] ‘USB-Blaster & AZAA|7 ZFojof sict,

Fle Edit View Processing Tools Window Help 5

Search altera.com @

ILéHardware Setup...l No Hardware I Mode: |JTAG '_l Progress: :

[”] Enable real-time ISP to allow background programming (for MAX I and MAX V devices)

o Erart File Device Checksum  Usercode  Program/ Verify Blank- Examine
o Configure Check
i stop output_filles/Test.sof ~ EP4CE6EZZ 00092A3F  00092A3F ] [

| 4% Auto petect |

{ Delate

5

Wiz change File..

[Bsaere ||| o1
|5 Add Device...
T Up

1 pown

EP4CEBEZ22

- 'Hardware Setup oA &2 U2 9fA ot Z3tH AZY 'Device 50l UeHUH, 1
T AH8E 212 Ad"std "ok 2 oAlolA & 'USB-Blaster [USB-0]'5 Ad=igte}.
m«% Hardware Setup F—gr

Hardware Settings | JTAG Settings

Select @ programming hardware setup to use when programming devices. This programming
hardware setup applies only to the current programmer window.

Currently selected hardware:

Available hardware items

Hardware
USB-Blaster

ile View Processing Tools Window Help:

Search altera.com ®

ll_l.‘_;, Hardware Setup...] USB-Blaster [USB-0] I Mode: [JTAG 'I Progress: :

["] Enable real-time ISP to allow background programming (for MAX I and MAX V devices)

o sart ‘ File Device Checksum  Usercode  Program/ Verify Blank-  Examine
Shart Configure Check
i Stap | | |output_files/Test.sof ~ EP4CE6E22 00092A3F 00092A3F

Nalata A I b
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Search altera.com

G Hardware Sefup... USE-Blaster [USB-0]

I”| Enable real-time ISP to allow background programming (for MAX I and MAX V devices)

o T

File Device Checksum Usercode | Program/ |Verify Blank-
Configure Check
| i Stop output_files/Test.sof ~ EPACEGE22 D0092A3F  DOD9ZA3F £l [ O

Examine  Security Erase SP
CLAMP

Bit

Search altera.com

Mode: |ITAG i

£, Hardware Setup...| [

[7] Enable real-time ISP to allow background programming (for MAX I and MAX V devices)

Progress:

File Device Checksum  Usercode  Program/ Verify  Blank-
o
Configure Check

dl 5top output_files/Test.sof  EP4CEGEZZ 00092A3F  00092A3F # ™

Examine  Security Erase
Bit

EP

CLAMP

‘Progress’o| Al ‘100%(Successful)’o] YJEPITIH Aoz

iy Programmer - D:/al‘lrra.’lil}spi,“qu;rru;‘hlhﬁii&é:st ~Test - Ipujlput_ﬁﬁT est.odf]*

Fle Edt View Processng Tools Window Help 5
&, Hardware Seup... Mode: |ITAG -

7] Enable real-time 15P to aflow background programming (for MAX I and MAX V devices)

Device Checksum  Usercode | Program/  Verify | Blank-  Examine
il 5tart Configure Check

6AT44 O00E7FSF FFFFFFFF &3] i} B8

o save e
Tihip |
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@ Half-Addero]] tjjst VHDL Z& ofjA.

-- import std_logic from the IEEE library
library IEEE;
use IEEE.std_logic_1164.all;

-- this is the entity

entity Test is

port ( A: in std_logic;
B: in std_logic;
SUM: out std_logic;
COUT: out std_logic);

end entity Test;

-- this is the architecture
architecture MY_HALF_ADDER of Test is
begin
SUM <= A xor B;
COUT <= A and B;
end architecture MY_HALF_ADDER;
-- end of file



